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Course Notes for Windows 8.1 Class 

Session 1 

Introduction 

This class is to help students become more comfortable with the Windows 8 Operating System. 

In introducing the Windows 8 operating system, Microsoft have combined two operating systems 

• A system consisting of “tiles” that is designed primarily for touch devices – tablets and phones 

• A system that is almost Windows 7 for those using keyboard and mouse. 

However, the two systems are not completely separate, and to use the keyboard and mouse system, 

you will need familiarity with the Touch version, and how to use it. This class will describe both 

operating systems and enable you to become familiar with both systems. 

What’s new in Windows 8 

Some of the key benefits of Windows 8 are: 

• It’s fast 

• To those who use a smart phone, there are many similarities in Windows 8 

• It is touch screen friendly 

• It is closely integrated with the Cloud, so you can store files in the Cloud and access them from 

any computer 

• Menus have been replaced by ribbons 

• It includes free virus software 

• Microsoft Xbox Music service is included for free – more on that later. 

In Windows 8.1 

• Apps have been improved 

• New Apps are included 

• Help screen now included 

• Improved integration with OneDrive 

• Libraries – hidden by default 

• Improved management of Start Up Apps 

• Easier System Image backup 

In Windows 8.1 Update 1 

• Boot to Desktop by default 

• Modern Apps on Desktop Taskbar 

• Taskbar is everywhere 



• Right Click on App for Menu 

• New Apps installed notifications 

• Disk Space info in PC Settings 

• Is Cortana better than Siri 

• Start Button on its way!! 

 

The Metro or TileWorld Screen 

Using Windows 8 

When you turn on your computer, the first screen is the Lock Screen 

 

This fine if you want to know the time, but to move on, click the mouse or press any key on the 

keyboard. This takes you to the Login screen. 

 

Type your password (or use one of the alternative approaches to log in) and you are taken to the Home 

Screen. 



 

If you have a desktop computer at home, you may wish to bypass the Enter Password screen. My advice 

is not to do that for a laptop, as others may have access to the computer. To bypass the Password 

screen, hold down the Windows key and tap R on your keyboard. A window will open. In the window, 

type “netplwiz” without the quotation marks, and press Enter. A window will open. 

 



If you uncheck the box in the red circle and click OK, you will be asked for your password (twice) and 

then the next time you log on, no password will be requested. 

The Start Screen 

The Start Screen can be thought of as a substitute for the old Start Button. It shows a selection of 

programs that you can launch. The Start Screen includes programs that are Apps and also the more 

complex programs that launch from the Desktop, such as Word, Excel, Quicken etc.  The Start Screen 

scrolls horizontally, using the wheel on the mouse, or ---. It should include the Apps and Programs that 

you use a lot. 

Managing tiles. 

Live tiles. One of the features that Microsoft introduced are Live Tiles – the tile shows a changing set of 

information, e.g. The mail tile shows a summary of the latest email, the Weather tile shows local 

weather conditions. If you find the live tiles too disturbing, you can turn the Live feature on and off. 

Right click on the tile, and a menu will appear. Select Turn Live Tile on or Off. 

The Menu also lets you Resize tiles. The tiles will automatically regroup to fill in the spaces. 

Tiles can be moved by holding down the left mouse button and dragging the tile to its new location.  

If you no longer use a tile on the Start Screen, you can Unpin it using the App Bar. It removes the tile 

from the Start Screen, but does not uninstall the App. 

All Programs 

As with Windows 7, there is an All Programs button on the Start Screen. Move the mouse to the lower 

left of the screen and an arrow will appear. Clicking this opens the All Programs screen. 

 



This shows all your Apps and Programs. They can be sorted by Name, by Most Used, by Date installed 

and by Category. 

Right clicking an App opens a menu and allows you to perform a variety of tasks including Pin to Start 

Screen. 

Personalizing the Start Screen 

A right click on the Start Screen – not on an App, opens an App Bar that allows you to customize the 

Start Screen. Names can be added to Groups. Of course, you can groups the Apps by dragging them to 

your preferred place as described earlier. To create a new group, drag an App that will be part of the 

new group to a space between the Groups and a vertical line will appear, and a new group will be 

formed. You can then name it as described above. 

Groups can be rearranged. Move the mouse and a – sign will appear in the lower right corner. Click it 

and the screen will zoom out. Groups of Apps can now be moved by dragging the group. 

Using Apps 

Open the Travel App. Right click on the App to show options. Review 

Repeat for Weather App. 

Zones (for Keyboard and Mouse) 

Top Left: 

When in the Start Screen, moving the mouse to each of the four corners of the screen will cause an 

action. To demonstrate, open two apps 

• Weather 

• Travel 

When in the Weather app, move mouse to the top left hand corner and a thumbnail of the Travel 

app will appear. Clicking it will open the Travel app.  Repeating this will return you to the Weather 

app. 

If you have more than two apps open and you move the mouse to the top left hand corner and slide 

the mouse down slightly, you will see thumbnails of all open programs. Clicking one will take you 

there. 

Bottom Left 

Moving the mouse to the bottom left and clicking the right button on the mouse will open a 

menu of useful programs, including a Shut Down command 

Top or bottom Right 

Moving the mouse to the top or bottom right hand corner opens the Charms Bar. 



 

Here are the icons in the Charms Bar 

• Search. Tap this icon to begin a search of your computer, fir anything – programs, documents, 

settings, emails, calendar appointments etc., 

• Share. Tap this icon to send what is selected to a friend by email or social network 

• Start. Tap this to return to the Start Screen 

• Devices. This offers options about whatever is connected to your computer – printers, Xbox, 

cameras etc. 

• Settings. Settings here means options for the App you are using at the moment. Below the App 

settings are six handy settings icons about your computer. Shut Down is under the Power icon. 

Underneath the six icons is “Change PC Settings” Clicking this will open the PC Settings panel, showing 

options for a range of setting about your computer. 

Keyboard Shortcuts 

Some very useful keyboard shortcut combinations. 

• Windows key + D:  Takes you to the desktop 

• Windows key + C:  Access the Charms Bar  

• Windows key + I:  Opens Settings. You can reach Control Panel from here if you are on the 

desktop when you use this shortcut 

• Windows key + Q:  Opens a Search screen. 

• Windows key + X:  Opens the Quick Access menu (also called the Power User Menu). There are 

many useful system tools here. This is an especially useful shortcut for power users. The Quick 

Access menu is shown below. 

• Windows key + C: Access the Charms bar 

• Windows key + I: Access the Settings charm 

• Windows key + H: Access the Share charm 

• Windows key + K: Access the Devices charm 

• Windows key + Q: Access the Apps Search screen 

• Windows key + F: Access the Files Search screen 

• Windows key + W: Access the Settings Search screen 

• Windows key + P: Access the Second Screen bar 

• Windows key + X: Access the Windows Tools Menu 

• Windows key + . : Move the screen split to the right 

• Windows key + Shift + . : Move the screen split to the left 

• Windows key + E: Open Computer 



• Windows key + R: Open the Run dialog box 

• Windows key + U: Open Ease of Access Center 

• Windows key + Pause/Break: Open the System page 

• Windows key + F1: Launch Windows Help and Support 

Task Switcher 

To see all open Apps and Programs, hold down Alt key and tap Tab. Tapping Tab will move you through 

all open Apps and Programs.  

On Screen Keyboard 

If you have a touch screen machine, an on screen keyboard will appear whenever typing is required. This 

does not happen for computers with keyboards.  

Apps included with Windows 8.1 

Alarms Internet Explorer Scan 

Calculator Mail OneDrive 

Calendar Maps Skype 

Camera Music Sound Recorder 

Desktop News Sports 

Finance PC Settings Store 

Food and Drink People Travel 

Games Photos Video 

Health and Fitness Reader Weather 

Help  + Tips Reading List  

 

Closing Apps 

Normally, you do not need to close an App. Just go onto the next App you want. However, if you do 

want to close it, move the mouse to the top of the screen and it will become a hand. Drag the hand 

down towards the bottom of the screen and the App will change to a thumbnail and then close. 

In Windows 8.1 Update 1, moving the mouse on the screen will show a Close button in upper right. Click 

the X to close 

Upgrading to Windows 8.1 

Most recently purchased computers will have Windows 8 installed. Microsoft has recently distributed 

version Windows 8.1. If you already have Windows 8 on your computer, you can get Windows 8.1 for 

free. 

To install Windows 8.1, go to the Start Screen and click or tap the Store icon. 



 

You will probably find Windows 8.1 as the first icon on display. If it is there, click it and follow the 

directions. It may take some time to upgrade – over one hour, so make some coffee and do something 

else. 

If Windows 8.1 is NOT on your Store when it open, you will need to update the Store before installing 

8.1. To do this, open the Charms Bar and select Settings. Click Change PC Settings at the bottom of the 

bar. A panel will open on the left. Click Update and Recovery, Windows Update and Check Now. After 

the update is complete, returning to the Store should show Upgrade to Windows 8.1. 

  



 

Session 2 

The Windows Desktop 

Difference between Apps and Programs 

Apps Programs 

Download from Store Get from anywhere 

Take up whole screen Normal Window 

Very Specialized Multi-Purpose 

Windows 8 only Most Windows versions 

Generally safe Can have viruses 

 

The Secret Start menu 

Move mouse to the bottom left of the Desktop screen, and Right click. A menu will open. 

 

Discuss menu options. Key ones are System; Control Panel; Search; Shut Down and Sign Out. 

If you wish to always open in the Desktop, in the Search box, type Navig and then select Taskbar and 

Navigation, and select the Navigation tab. You can then select the option you prefer. 

Restoring the “old” Start Menu 

Make Windows 8 work more like Windows 7 or XP. 



If you have a computer that does not have a touch screen, you may find the Apps on the Start Screen 

less that useful. It is possible to start Windows 8 at the Desktop and also to add a Start Menu just like 

Windows 7 or Windows XP. Here are the steps. 

• In your browser, enter http://www.classicshell.net/ and this will take you to the Classic Shell 

web site. Click on the Download button and follow the directions to install Classic Shell. Once 

installed, a window will open asking you your choice of Start Button. 

 

The Classic style is similar to Windows XP. Windows 7 style is self-explanatory. 

By checking the button – Replace Start Button, you can select a design of Start button. If you do not 

make a selection, the Start button will be the Windows 8 Start Screen button. 

The Basic Settings tab gives you a range of options. You can decide your preferences. The last item is 

Skip Metro Screen. Checking this item will make Windows boot directly to the Desktop. Click OK once 

you have made your choices. 

Windows Management.  

• Open Wordpad using Start Menu Search Box.  

• Show how to resize Windows using sides and corners, how to move Windows, how to snap to 

sides, and how to close Window. Demonstrate the Show Desktop button. 

• Open Notepad using Start Menu. Demonstrate drag left and right (tiling) 

• Discuss differences between Ribbons and Menus and discuss this is the new standard for 

Windows 

• Demonstrate Wordpad button – Save, save as, Print, New, Open 

• Enter data in Wordpad and save to Desktop. Discuss Dialog Box. 



File Explorer 

Move the mouse to the bottom left corner of the screen and right click. Select File Explorer.  

 

Discuss elements of window - File menu, the Home tab, the Share Tab and the View Tab. 

The File Menu 

o Open New Window 

o Open Command Prompt. (need to have a file or folder selected) 

o Open Windows PowerShell 

o Delete History 

o Help 

o Close 

o Frequent Places 

Home Tab 

o Copy, Paste, Cut 

o Copy Path 

o Paste Shortcut 

o Move to, Copy to 

o Delete 



o Rename 

o New Folder 

o New Item 

o Easy Access 

o Open 

o Edit 

o History 

o Select all, Select None 

o Invert Selection 

Share Tab 

o Email 

o Zip 

o Burn to Disk 

o Print  

o Fax 

o Specific people 

o Stop Sharing 

o Advanced Security 

View Tab 

Controls the look and arrangement of icons. Demonstrate different layouts. 

In a few places, you may get a “bonus” tab – Library Tools, Music Tools, Picture Tools, and Recycle Bin 

etc. 

Searching using the Address Bar 

When you click the small Folder icon at the left end of the address bar, you can type in a variety of 

commands. 

• A web address – try with CLCEwing.org. The Computer Learning web site will open 

• A search phrase. Windows assumes that you wish to check the internet for that search. 

• A folder name, such as This PC, Documents, Music etc. That window will open. 

• A program name. 

Open Windows Explorer and discuss File Structure. Handout. 

• Show changing triangle 

• Discuss file structure. See diagram overleaf. 

• Open WordPad using Search Box and enter some text.  Click WordPad icon and save file 

o Click Documents in left column 

o Right click on right and select new folder. 

o Enter your name and hit Enter 

o Make sure that new folder is shown in Save in. 



o Give the file a name. 

� A folder name can contain up to 255 characters, including spaces 

� Try to keep names short, simple, and meaningful so they are easy to remember 

� A folder name can contain any characters except for the following: 

\ / : * ? " < > |  

o Click Save 

o Repeat for additional folders (Recipes) and new files 

• Renaming a folder 

o Right-click it and choose Rename, or select it and press F2 

o The folder’s name is selected to indicate that you can enter a new name 

o Type the new name and press Enter  

• Moving files and folders 

o Drag a file or folder to a new location  

o Right-click and drag a file or folder, and choose “Move here”  

o Select the file or folder, click Organize, and choose Cut; open the new location, click 

Organize, and choose Paste  

o Right-click the file or folder and choose Cut; open the new location, right-click a blank 

area, and choose Paste  

o Select the file or folder and press Ctrl+X to cut; open the destination folder and press 

Ctrl+V to paste 

• Copying files and folders 

o Hold down Ctrl, and drag the file or folder  

o Right-click and drag, and choose “Copy here” from the shortcut menu  

o Select the file or folder, click Organize, and choose Copy; select the new location, click 

Organize, and choose Paste  

o Right-click the file or folder and choose Copy; right-click the destination folder and 

choose Paste  

o Select the file or folder and press Ctrl+C to copy; select a destination folder and press 

Ctrl+V to paste 

• Deleting files and folders 

o Select the item and press the Delete key on your keyboard  

o Drag the item to the Recycle Bin  

o Right-click the item and choose Delete  

• Restoring deleted files 

o Double-click the Recycle Bin to open it 

o Locate and select the object you want to restore 

 

Personalize your Desktop 

• Right click on Desktop and select Personalize. 



• Try different approaches. 

 

 

  



Exercise on creating File 

Structure

My 
Documents:

Recipes

Appetizers

Pasta

Fish

Meat

My Photos

Grandchildren

House

Inside

Outside

Garden

Church

Senior Group

Italian supper

Vacations

State Parks

Montana

Yellowstone

Jersey Shore

Spring Lake

Cape May

France

Paris

Wine district

 



Session 3 

PC Settings 

Settings are accessed from the Charms Bar – point to top or bottom right and select Settings. Choices 

are: 

• Desktop 

• Control panel 

• Personalization 

• PC Info 

• Help. 

Below that are six additional options. 

• Network 

• Loudspeaker volume as a percentage 

• Unavailable 

• Notifications 

• Power 

• Keyboard 

More importantly, clicking Change PC Settings opens a new range of options 

PC and Devices. Discuss further menu and benefits 

Accounts – Microsoft and Local Accounts 

A Microsoft account is required to access the App Store and OneDrive. It is recommended that 

you set up a Microsoft account. If you have previously set up a Local Account (giving you access 

just to your local computer), accessing the Accounts in Change PC Settings will provide you with 

the option to set up a Microsoft account. Make sure you select a secure password and keep it 

safe. You will need it for several options in Windows 8. 

OneDrive 

OneDrive (previously SkyDrive) is Microsoft’s cloud storage option. Windows 8 is set up to save 

all your files to OneDrive, although you always have the option to select an alternative location, 

i.e., on your local hard drive. However, if you do not make a choice, your file will automatically 

be saved in OneDrive. This of course ensures that your file are available using any computer, so 

long as you know your Microsoft account and password. 



In the OneDrive option in PC Settings, you can see the space you are using in OneDrive and also 

BUY more space if you so decide. However, there are many free options, so think this through 

before spending your money! 

Update and Recovery 

The Update and Recovery option offers 3 sub options 

• Windows Update. This allows you to select your options to allow Microsoft to update 

your computer with its updates to Windows 8. My recommendation is to Automatically 

Install Updates. 

• File History. Windows 8 introduced the concept of creating a record of new files that 

you create in File History. To activate this option, you will need to specify a location that 

your File History will be stored. Remember that it may grow to be quite large so make 

sure that there is space to the History to grow. 

• Recovery. This option give you very powerful options to repair your computer when 

things go badly wrong. You can refresh your PC without losing your files and photos, or 

you can return your computer to its original state. This last option will DELETE all your 

personal; file, photos, music and favorites, so make sure you have a backup before 

initiating this option. 

Discuss Control Panel. Discuss Categories and Large Icons 

• Mouse. Change settings 

• Keyboard. Change settings 

• Power Options. Change settings for monitor and hard drives. 

• Firewall.  

o Prevents access to your machine by unauthorized Internet or network users  

o Runs in the background and does not require regular management  

• View the status of Windows Firewall 

o Open the Control Panel  

o Click Windows Firewall 

o Verify that Windows Firewall is enabled  

o Close the Windows Firewall window 

• Windows Update. Check for updates, change settings. Windows Anytime Upgrade 

Ctrl+Alt+Delete account options 

• Lock this computer  

• Switch user  

• Sign Out 

• Task Manager. Demonstrate 



Discuss YouTube 

Videos on Windows 8 available. Demonstrate 

Discuss Windows Defender 

No need to pay for Virus and Malware protection – it is included. 

 

 


